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Preface

Wise Package Studio® helps system administrators and desktop integration labs
streamline the process of packaging software applications for delivery to end users. It
encompasses all phases of an application’s lifecycle, from the initial repackaging to the
final testing and distribution.

Wise Package Studio improves on traditional packaging practices by combining best
practice methodologies with industry-leading software installation technology. In
addition, software packages created with Wise Package Studio can be distributed
through many of the leading software distribution products currently on the market.

Documentation Roadmap

This documentation assumes that you are proficient in the use of the Windows operating
system. If you need help using the operating system, consult its user documentation.

Use the following sources of information to learn this product.

Online Help

The online help contains detailed technical information and step-by-step instructions for
performing common tasks.

Access help in the following ways:
e To display context-sensitive help for the active page or dialog, press F1.

e To select a help topic from a table of contents, index, or search, select Help menu >
Help Topics.

If you need help and cannot find the answer in the documentation, see Getting Help and
Product Support on page 6.
Reference Manual

All the material in the online help is also available in a .PDF-format reference manual,
which you can access by selecting Help menu > Reference Manual.

The following tools have separate manuals: ConflictManager, Linux Package Editor,
Mobile Device Package Editor, Software Manager, Virtual Package Editor, Windows
Installer Editor, and WiseScript Package Editor.

Getting Started

The Getting Started Guide contains system requirements, installation instructions, and a
tutorial. You can access a .PDF version of the Getting Started Guide from the Windows
Start menu.

The installation and repository management sections of the Getting Started Guide are
also available as online help. In the Wise Repository Manager, select Help menu > Help
Topics, or click the Help button on any of the Wise Package Studio installation dialogs.
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Release Notes

A release notes document, in .HTM format, covers new features, enhancements, bug
fixes, and known issues for the current version of this product. Access the release notes
in the following ways:

e Browse the product CD.
e Select it from the Altiris program group on the Windows Start menu.

e If you are a registered customer, visit http://support.wise.com to enter the Support
Center, and then click the Downloads link.

Windows Installer SDK Help (Windows Installer Editor only)

You can get technical details about Windows Installer from its own help system, which is

written by Microsoft for a developer audience. In Wise for Windows Installer, select Help
menu > Windows Installer SDK Help.

Version 3.1 of the Windows Installer SDK Help is provided. If you have obtained a later
version, links from the Wise product documentation to the Windows Installer SDK Help
might not work.

Getting Help and Product Support

If you need help and cannot find the answer in the documentation (see Documentation
Roadmap), you can use one of the many support resources that are available to you as
a registered customer.

Use the Technical Support Center

Registered customers can use the Technical Support Center, located at http://
support.wise.com, to submit online support requests, register products, manage
customer information, download updates, or search the Knowledgebase. The
Knowledgebase contains how-to procedures, answers to common support questions,
and workarounds.

Visit Our Newsgroups
Visit http://forums.altiris.com/. Newsgroup postings by your peers contain answers,
tips, analysis, and other comments. Contribute your own expertise to help others.

Ask Our Support Team

If you can’t find an answer in our online resources, you can obtain support by phone or
online at http://support.wise.com. Flexible payment options are available to meet your
support needs. For additional details about our support services, visit www.wise.com/
supportoptions.asp or call 1-734-456-2600.

Before you contact technical support, obtain the following:

e Serial number and product version, which you can find by selecting Help menu >
About.

e Operating system version and service pack version if applicable.
e A description of what you do before the problem occurs.

e The text of any error messages that appear.
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e Your name, company name, and how to contact you.

e Contract number or payment information, if applicable.

Take Advantage of Our Consulting and Training Services

When you have a challenging repackaging or installation problem, our consultants can
help with script writing, repackaging, installation development, and other solutions that
are fully customizable to fit your project and budget. Visit www.wise.com/consulting.asp
for details.

To upgrade your installation and packaging skills, consider training. Our certified
instructors draw from practical experience to provide relevant course content. Visit
www.wise.com/training.asp for course descriptions and schedules.

Contact Our Sales Department

Contact our Sales department to purchase additional products, upgrades, support
services, or consulting and training services.

U.S.: +1 800 554 8565

EMEA: +8000 ALTIRIS (2584747) or +49 211 68 773 222

Other International: +1 734 456 2100

E-mail: wisesales@altiris.com
Web Site: www.wise.com/ordercentermain.asp
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Chapter 1

Installation Best Practices for Wise Package

Studio

This section provides information on the best way to install and configure Wise Package

Studio for your environment.

Topics include:

e System Requirements

e Before You Install Wise Package Studio

e Choosing the Location for the Share Point Directory

e Configuration Best Practices

e Authentication Best Practices

System Requirements

Note

Wise Package Studio cannot be installed on any computer that contains Wise for Visual

Studio .NET or Wise for Windows Installer (any edition or version).

Wise Package Studio Requirements

The requirements below apply to all editions and modules of Wise Package Studio,

except as noted.

Wise Package Studio
Requirement

Value

Computer/processor

PC with a Pentium Ill-class processor, 800
MHz

Operating system

Windows 2000 or later (SP4
recommended)

Windows XP Professional (SP2
recommended)

Windows Server 2003

Note

SetupCapture cannot be run on Windows
95, 98, or NT4. To capture on those
operating systems, use Wise Web
Capture, which is described in the Wise
Package Studio Help.
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Wise Package Studio
Requirement

Value

Microsoft Internet

Explorer

5.5 or later*

* Reports require 6.0 or later, or Microsoft
XML Parser (MSXML) 3.0 Service Pack 7.

RAM

256 MB; 1 GB recommended

Free space on

Standard Edition: 150 MB

installation driv: . . .
stallation drive Professional Edition, Server with share

point: 150 MB + (number of applications x
30 MB)

Professional Edition, Client: negligible

Network (not applicable = Windows-based network environment
to Standard Edition)

Database (not Your environment must contain at least
applicable to Standard one server that has one of the following:

Editi . . .
ition) e Microsoft SQL Server (English version

only). Version 7.0 required; 2000
recommended. SQL Server 2005 and
SQL Server 2005 Express are
supported.

e Microsoft Data Engine (MSDE).

MSDE does not support Wise Package
Studio client installations. If you will install
Wise Package Studio in a client-server
configuration, use SQL Server.

If you are upgrading from a previous
version of Wise Package Studio that used
Access databases, the Wise Repository
Manager will upgrade the databases to
SQL Server or MSDE.

Installations that you create using Wise Package Studio can be run on any Windows
operating systems that are supported by Windows Installer.

Windows 95 and earlier versions of Windows NT 4.0 do not contain Windows Installer
software by default, so if you plan to run an installation on those operating systems,
configure it to pre-install Windows Installer. To do so, use the option provided in
Installation Expert > Prerequisites page.

Web Applications Requirements

The Wise Package Studio Web applications are available only if you purchased the
following:

e Management Reports: included with Enterprise Management Server module.

e Preflight Data Collector and Preflight Analysis: included with the Quality Assurance
module.

e Wise Web Capture: included with the Professional Edition.
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Installation Best Practices for Wise Package Studio

Web Application
Requirement

Value

Computer/Processor

Pentium 111, 800 MHz

Operating system

As required by Microsoft Internet
Information Server

Microsoft Internet
Information Server

(11S)

4.0 or later required; 5.0 recommended

Microsoft Internet
Explorer

5.5 or later required; 6.0 recommended

RAM

256 MB; 1 GB recommended

Free space on
installation drive

10 MB

Database (not
applicable to Standard
Edition)

Your environment must contain at least
one server that has one of the following:

e Microsoft SQL Server (English version
only). Version 7.0 required; 2000
recommended. SQL Server 2005 and
SQL Server 2005 Express are
supported.

e Microsoft Data Engine (MSDE).

MSDE does not support Wise Package
Studio client installations. If you will install
Wise Package Studio in a client-server
configuration, use SQL Server.

.NET Framework (Wise
Web Capture only)

1.1 must be installed on the server. Later
versions may be installed also, but Wise
Web Capture works with version 1.1 only.

ASP

Must be installed and enabled

ASP.NET (Wise Web
Capture only)

Must be installed and enabled

ISAPI extensions

Must be enabled

.NET Framework System Requirements

The .NET Framework is required for advanced .NET support in Windows Installer Editor.
The .NET Framework requires Microsoft® Internet Explorer 5.01 or later and one of the
operating systems supported by Wise Package Studio.

Version 1.1 of the .NET Framework is required by the Wise Web Capture tool. Later
versions may be installed also, but Wise Web Capture works with version 1.1 only.

Wise Package Studio Getting Started Guide

10



Installation Best Practices for Wise Package Studio

Before You Install Wise Package Studio

You might need to gather information, from a team leader, system administrator,
database administrator, or other team members, that will enable you to install Wise
Package Studio correctly for your environment.

Review the Configuration Best Practices on page 12 to determine the best
configuration for your environment.

If you are upgrading from a previous version of Wise Package Studio, back up the
existing share point directory and Wise Package Studio databases.

Have serial numbers available during installation. If this is an upgrade, you also
need the serial number of the previous version. To find this, open the previous
version of Wise Package Studio and select Help menu > About.

Find out what share point directory to use. In a multi-user environment, the share
point directory must be on a shared network drive. All users in a workgroup must
specify the same share point directory during installation. This lets all users access
the same packages and data. See Choosing the Location for the Share Point
Directory on page 12.

If you have been using a previous version of Wise Package Studio, you can use your
existing share point, but data will be updated to a new format.

If you are installing the Professional Edition, obtain the following information about
the databases you are using for Wise Package Studio:

m The name of the server that contains the database and the authentication
method (NT or SQL Server) that the database uses.

m Whether the database has been created or whether you need to create it during
installation. If it does not exist or needs to be upgraded, you need database
administrator privileges to create or upgrade it.

m  So that you can create databases, either your currently logged on user profile
must have database administrator privileges on the database server, or you
must have the SQL user name and password of a database administrator
available.

m  If you plan to use a SQL Server or MSDE database server that uses SQL Server
authentication, you will need to create users during installation. These users will
have access to the database you create. You need to know what user IDs to
create.

If you are performing a client installation, obtain the following information about the
server installation that the client will connect to.

m The name and location of the share point directory that was configured during
the server installation.

m  (Network Client installations.) The location of the Wise Package Studio directory
that was specified during the server installation.

For a list of the options for installing Wise Package Studio, see Installation Options on
page 22.
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Choosing the Location for the Share Point Directory

» Not available in Standard Edition.
The Standard Edition does not use a share point directory.

The recommended location of the share point directory depends on your environment
and the edition of Wise Package Studio you have purchased. (Also see Configuration
Best Practices on page 12.)

Where to Locate the Share Point Directory

The share point directory must reside on the same computer as the Wise Package Studio
application files. Versions of Wise Package Studio earlier than 6.0 did not enforce this. If
you are upgrading to 6.0 or later, and your share point directory is not on the same
computer as Wise Package Studio, see Upgrading an Unsupported Wise Package Studio
Configuration on page 19.

Environment Share Point Location

Single user installing Local or network directory.
Professional Edition

Team, sharing project Shared network directory accessible to
files, and installing team members.

Professional Edition or
Enterprise Management
Server

In a large enterprise with multiple teams,
each team might use a different share
point directory and Wise Software
Repository.

When the share point directory is on a shared network drive, all users in a workgroup
must specify the same share point directory during installation. This lets all users access
the same packages and data.

How is the Share Point Directory Created?

e During the initial Wise Package Studio server installation, the share point directory
is created and shared by the Wise Repository Manager.

e During a client installation, a new share point directory is not created. Instead, you
must specify the share point directory that was configured during the server
installation.

e During creation of a new Wise Software Repository, the share point directory is
created and shared by the Wise Repository Manager.

Configuration Best Practices

> Professional Edition only.
Installing Wise Package Studio - Standard Edition is relatively simple; it can be installed

in one basic configuration only and typically is installed by a single user on their local
computer.
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Installation Best Practices for Wise Package Studio

When you install Wise Package Studio - Professional Edition in a multi-user environment,
you have several options for configuring the installation. This section describes the
configurations that are supported. Review these configurations before you install Wise
Package Studio.

One important change from previous versions is that the share point directory must
reside on the same computer as the Wise Package Studio application files. Versions of
Wise Package Studio earlier than 6.0 did not enforce this. If you are upgrading to 6.0 or
later, and your share point directory is not on the same computer as Wise Package
Studio, see Upgrading an Unsupported Wise Package Studio Configuration on page 19.

See:

Dedicated Servers Configuration

Dedicated SQL Server Configuration (page 15)

Single Server Configuration (page 16)

Additional Wise Package Studio Configurations (page 17)

Upgrading an Unsupported Wise Package Studio Configuration (page 19)

Wise Package Studio Getting Started Guide 13



Installation Best Practices for Wise Package Studio

Dedicated Servers Configuration
» Professional Edition only.

Recommended environment:
e Medium to large packaging teams in multiple locations.
e Large number of users connecting at one time.

e Teams using Preflight Deployment (requires the Quality Assurance module).

Locate the Web Server as close as possible to the end user desktops on which
preflight packages will be run.

Package Studio Web Server
Server

SQL Server

!

s Clients
Computer What to Install
Dedicated Wise e Wise Package Studio server

Package Studio Server e Share point directory

Dedicated SQL Server e SQL Server

e Wise Package Studio databases

Dedicated Web Server e 1IS
e ASP
e ASP.NET
e |ISAPI extensions

e Wise Web applications

Clients Wise Package Studio client

Wise Package Studio Getting Started Guide 14



Installation Best Practices for Wise Package Studio

Dedicated SQL Server Configuration

» Professional Edition only.

Recommended environment:
e Medium to large packaging teams in a single location.

e Teams not using Preflight Deployment.

Locate the Web server as close as possible to the clients.

‘< g

Package Studio/Web Server SQL Server
Clients
Computer What to Install

Wise Package Studio/ e Wise Package Studio server

Web Server e Share point directory
e |IS
e ASP
e ASP.NET

e ISAPI extensions

e Wise Web applications

Dedicated SQL Server e SQL Server

e Wise Package Studio databases

Clients Wise Package Studio client

Wise Package Studio Getting Started Guide 15



Single Server Configuration

Installation Best Practices for Wise Package Studio

» Professional Edition only.

Small Team

Recommended environment:

e Single, small team (1 to 5 packagers).

e Managing 500 or fewer applications.

e Team not using Preflight Deployment.

Package Studio/Web/SQL Server

Clients

Computer What to Install

Dedicated Server °

Wise Package Studio server
Share point directory

SQL Server (for client support) or MSDE
(local computer use, non-client support)

Wise Package Studio databases
1S

ASP

ASP.NET

ISAPI extensions

Wise Web applications

Clients Wise Package Studio client

Wise Package Studio Getting Started Guide
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Installation Best Practices for Wise Package Studio

Single User

Recommended environment: Single user with no expected growth. This configuration is

not scalable.
Package Studio/Web/SQL Server
Computer What to Install
Dedicated Server e Wise Package Studio server
e Share point directory
e  SQL Server (for client support) or MSDE
(local computer, non-client support)
e Wise Package Studio databases
e |IS
e ASP
e ASP.NET
e ISAPI extensions
e Wise Web applications
Clients no clients

Additional Wise Package Studio Configurations

» Professional Edition only.

After you have determined which of the supported Wise Package Studio configurations is
best for your environment, decide whether you need to support multiple Wise Software
Repositories or databases.

Multiple Wise Software Repositories

In a large enterprise with multiple teams, each team might use a different share point
directory and Wise Software Repository. Because a Wise Package Studio server can be
associated with only one active repository at a time, each team must install their
repository on a different server.

With Enterprise Management Server, members of one team can subscribe to packages in
a Software Manager database that is managed by another team. In the example below,
each team has subscribed to packages in the other team’s Software Manager database.

Wise Package Studio Getting Started Guide 17



Installation Best Practices for Wise Package Studio

Team 1 subscribes to Team 2’s
Software Manager database

Team 2 subscribes to Team 1’s
Software Manager database

Team 1 Server Team 2 Server

!

Note
For ease of illustration, the single server configuration is shown. This concept also works
with the other recommended Wise Package Studio configurations.

Team 1 Clients

Team 2 Clients

Additional Workbench Database

With Enterprise Management Server, you can maintain an additional, external
Workbench database containing customized processes. Users creating new projects can
connect to an external database and use its process templates. This lets you maintain
process templates in a single database that can be distributed across departments or

regions.
Team 1 Server
Uses process templates
from Corporate Server
Corporate Server
@ Uses process templates

; from Corporate Server

Team 1 Clients

Team 2 Server

Team 2 Clients

Wise Package Studio Getting Started Guide 18



Installation Best Practices for Wise Package Studio

Note
For ease of illustration, the single server configuration is shown. This concept also works
with the other recommended Wise Package Studio configurations.

Multiple Software Manager Databases
You might want to use multiple Software Manager databases in these instances:

e If you import a large number of applications for a large organization, you can use
multiple databases to reduce the database size.

e If you are repackaging for multiple operating systems, you can use a separate
database for each target operating system.

e If your organization has multiple, decentralized departments, each using a different
set of packages, you can use a separate database for each department. This
concept is similar to using package groups, but on a larger scale.

Each database should reside on its own server. Running multiple databases on a single
server degrades performance. In addition, you cannot run the Wise scheduled tasks,
which import packages and refresh package subscriptions on a server-based installation,
on more than one database on a single computer.

\/

SQL Server 1 SQL Server 2
Software Manager Software Manager
database 1 database 2

Package Studio
Server
Share point directory

Clients

Upgrading an Unsupported Wise Package Studio Configuration

» Professional Edition only.

Although it was not recommended, previous versions of Wise Package Studio allowed
the share point directory and the Wise Package Studio installation to be on different
servers. With the release of Wise Package Studio 6.0, this configuration is not supported
because the Wise Task Manager, a server-side service, requires the share point directory
and the Wise Package Studio installation to be on the same server.

If you currently have this configuration, you cannot simply move the share point
directory. Instead:

Wise Package Studio Getting Started Guide 19



Installation Best Practices for Wise Package Studio

1. Install Wise Package Studio server on the computer that contains the share point
directory. The server installation does not use up a license unless someone actually
uses Wise Package Studio on that computer.

2. On each client computer, access the Workbench Preferences dialog > Repository tab
and verify that the share point directory on the new Wise Package Studio server is
specified.

Before

Package Studio/Web/
SQL Server
> e Wise Package Studio
e Web applications *
e \Wise databases *
File Server * Can also reside on separate
e Share point directory servers
Clients
After

Wise Package Studio server is on the computer that contains the share point directory.
The Wise Package Studio clients use the share point directory on the new Wise Package
Studio server.

Web/SQL Server

e Web applications *
- e Wise databases *

* Can also reside on separate

servers

Package Studio

Server

e Share point directory
e Wise Package Studio

Authentication Best Practices

For each Wise Package Studio database (Workbench, Software Manager, and Wise

Services), you can:

Wise Package Studio Getting

Specify the logon information for a database administrator (DBA).

Define how user names and passwords should be validated:

Started Guide
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Installation Best Practices for Wise Package Studio

You can use either SQL Server or Windows NT authentication.

Environment Authentication Method
Client users have local NT SQL Server only

accounts. (recommended).

Client users have a domain Windows NT or SQL Server.

account on the SQL server, and
have read and write permissions.

If you have installed SQL Server or MSDE with NT authentication only, the Wise Task
Manager, which manages operations on the Wise Package Studio server, will not work.
Therefore, during the Wise Package Studio database configuration, the authentication
method is changed to mixed mode (NT and SQL). If you have any questions about how
this change affects SQL Server security, ask your database administrator.

(Quality Assurance module only.) For best results with the Preflight Deployment feature,
use Windows NT authentication for the Wise Services database.
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Chapter 2
Installing Wise Package Studio

Wise Package Studio is comprised of several software components. Before you install
Wise Package Studio, refer to the information in this section to learn about the product
configurations and options that will meet your requirements.

Topics include:
e Installation Options
e Instructions for installing the various configurations of Wise Package Studio:
m  |nstalling the Standard Edition
m  |nstalling the Professional Edition, Server
m  Installing the Professional Edition, Client
m  Installing Web Applications
e Starting Wise Package Studio
e Registering Your Software

e Converting an Evaluation Version to a Production Version

Installation Options

You can install different configurations of Wise Package Studio.

Standard Edition

Consists of the Workbench interface and tools for package creation. The Standard
Edition can be installed in one basic configuration only. It typically is installed by a single
user on their local computer. See Installing the Standard Edition on page 24.

Professional Edition

Consists of the Workbench interface and tools for package creation, management, and
and conflict resolution. It also includes the Altiris Software Virtualization Agent (SVS
Agent). You can install Wise Package Studio Professional Edition in several different
configurations and purchase additional modules that extend its functionality: Quality
Assurance, Enterprise Management Server.

The Professional Edition has 3 installation types:

e Server
The server installation includes the share point directory and the Wise Package
Studio databases.

In a single-user environment, you can install the Professional Edition on your local
computer. In effect, your local computer is the server. We recommend that you do
this only if you do not plan to add users in the future.
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In the more typical group environment, you run the server installation on a shared
network location. Then, you run the client installation on individual users’
computers.

See Installing the Professional Edition, Server on page 25.

e Client
The client installation uses the share point directory and Wise Package Studio
databases that are installed on the server. In a client installation, you can install the
Wise Package Studio program files on the client computer, or install shortcuts and
support files that connect to the Wise Package Studio program files that are installed
on the server.

See About the Wise Package Studio Client Installation on page 28 and Installing the
Professional Edition, Client on page 28.

e Web
The Web option appears only if Internet Information Services (11S) is installed and if
you enter a serial number for at least one product that includes a Web application
(Professional Edition, Quality Assurance, or Enterprise Management Server).

Wise Package Studio Web applications are:

®  Management Reports
Requires an Enterprise Management Server or bundle serial number. This lets
managers use a Web interface to view management reports stored in the
Software Manager database without having installed any Wise Package Studio
software on their computers.

m  Preflight Data Collector and Preflight Data Analysis
Requires a Quality Assurance or bundle serial number. These applications are
part of the Preflight Deployment feature and are used for evaluating
installations.

m Wise Web Capture
Requires a Professional Edition serial number. This lets repackagers capture
installations on a clean machine without installing any additional software.

See Installing Web Applications on page 32.

Enterprise Management Server Module

Installs components needed for project management, viewing reports, accessing
multiple databases, and automatically importing package information. Includes user and
group-based security, which can be integrated with NT authentication. It includes
Management Reports.

This module can be installed only with Wise Package Studio - Professional Edition. Enter
an Enterprise Management Server or bundle serial number during installation, or
through User Licensing Setup in Workbench after installation.

Quality Assurance Module

Installs these quality assurance tools: Test Expert and Package Instrumentation. It also
adds the ability to create new validation modules and validation rules in Package
Validation.

This module can be installed only with Wise Package Studio - Professional Edition. Enter
a Quality Assurance or bundle serial number during installation, or through User
Licensing Setup in Workbench after installation.
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Wise Package Studio Upgrade
To upgrade from a previous version of Wise Package Studio:
1. Back up the existing share point directory and Wise Package Studio databases.

2. Run the installation and, on the User Information dialog, enter a new serial number
and the previous version serial number.

The installation uninstalls the previous version of Wise Package Studio and installs
the new version. It does not delete the existing share point directory, Wise Package
Studio databases, or settings.

3. After the installation finishes, open the Wise Repository Manager to upgrade the
share point directory and databases. See Upgrading Databases on page 42.

Installing the Standard Edition

The Standard Edition consists of the Workbench interface and tools for package creation.
The Standard Edition can be installed in one basic configuration only. It typically is
installed by a single user on their local computer.

For help during installation, click the Help button on any dialog.

Note

The Wise Package Studio installation is run from an .EXE that installs Wise Package
Studio and, in the Professional Edition, the Altiris Software Virtualization Agent. During
installation, the Wise Package Studio .MSI file is extracted to \Program
Files\Altiris\Setup Files\Wise Package Studio. The Software Virtualization Agent .MSI file
is extracted to \Program Files\Altiris\Setup Files\Software Virtualization Solution. Do not
delete these files because they are needed for future repairs.

Starting the Installation
1. Close any other applications that are running.
2. Start the installation program:
m  From a downloaded file: double-click the installation file.

m  From the product CD:

When you insert the product CD, a Welcome dialog appears. Click the button
that installs Wise Package Studio. If the Welcome dialog does not appear, use
Windows Explorer to browse to the CD, then open the file named Autoplay.exe.

3. On the Welcome dialog, click Next.

4. On the License Agreement dialog, read the license terms, mark 1 accept the
License Agreement, and click Next. If you do not accept the license agreement,
you cannot continue the installation.

5. Complete the User Information dialog:

m  Serial Numbers
Click Add to display a dialog on which you can enter the serial number.

¢ Serial Number
Enter a serial number for the Standard Edition.
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¢ Previous Serial Number
If you are upgrading from a previous version of Wise Package Studio, enter
the serial number for the previous version. If you don’t know the previous
version serial number, open Wise Package Studio and select Help menu >
About. The serial number appears on the About dialog.

m  Install Evaluation Version
Mark this to install an evaluation version without a serial number.

m  Full Name, Organization
Enter this identifying information.

6. Complete the remaining dialogs, which are described below.

Wise Package Studio Evaluation dialog

This dialog appears only when you mark the Install Evaluation Version checkbox on
the User Information dialog.

Mark the option for the edition of Wise Package Studio to install. If you install the
Professional Edition, you can also mark options to include the Enterprise Management
Server module and the Quality Assurance module.

Wise Package Studio Directory dialog

In Destination Directory, specify where to install the Wise Package Studio application
files.

Ready to Install the Application dialog

Click Next to start installing.

Final dialog

When the installation finishes, a dialog indicates that the installation has been
completed successfully.

On the final dialog, click Finish to exit the installation.

If you are prompted to restart your computer, do so.

Installing the Professional Edition, Server

The Professional Edition consists of the Workbench interface and tools for package
creation, management, and conflict resolution. The server installation includes the share
point directory and the Wise Package Studio databases.

For help during installation, click the Help button on any dialog. For configuration
recommendations, see Configuration Best Practices on page 12.
Before the Installation

Ensure that SQL Server or MSDE is running on the computer on which you will install the
Wise Package Studio databases.

If you are upgrading from a previous version of Wise Package Studio, back up the
existing share point directory and Wise Package Studio databases.
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Note

The Wise Package Studio installation is run from an .EXE that installs Wise Package
Studio and, in the Professional Edition, the Altiris Software Virtualization Agent. During
installation, the Wise Package Studio .MSI file is extracted to \Program
Files\Altiris\Setup Files\Wise Package Studio. The Software Virtualization Agent .MSI file
is extracted to \Program Files\Altiris\Setup Files\Software Virtualization Solution. Do not
delete these files because they are needed for future repairs.

Starting the Installation
1. Close any other applications that are running.
2. Start the installation program:
m  From a downloaded file: double-click the installation file.

m From the product CD:
When you insert the product CD, a Welcome dialog appears. Click the button
that installs Wise Package Studio. If the Welcome dialog does not appear, use
Windows Explorer to browse to the CD, then open the file named Autoplay.exe.

3. On the Welcome dialog, click Next.

4. On the License Agreement dialog, read the license terms, mark 1 accept the
License Agreement, and click Next. If you do not accept the license agreement,
you cannot continue the installation.

5. Complete the User Information dialog:

m  Serial Numbers
Click Add to display a dialog on which you can enter the serial number.

¢ Serial Number
Enter a serial number for the Professional Edition. Also enter serial numbers
for any additional modules that you might have purchased (Quality
Assurance and Enterprise Management Server).

¢ Previous Serial Number
If you are upgrading from a previous version of Wise Package Studio, enter
the serial number for the previous version. If you don’t know the previous
version serial number, open Wise Package Studio and select Help menu >
About. The serial number appears on the About dialog.

m  Install Evaluation Version
Mark this to install an evaluation version without a serial number.

m  Full Name, Organization
Enter this identifying information.

6. Complete the remaining dialogs, which are described below.

Wise Package Studio Evaluation dialog

This dialog appears only when you mark the Install Evaluation Version checkbox on
the User Information dialog.

Mark the option for the edition of Wise Package Studio to install. If you install the
Professional Edition, you can also mark options to include the Enterprise Management
Server module and the Quality Assurance module.
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Select Installation Type dialog

Mark Server.

Wise Package Studio Directory dialog

In Destination Directory, specify where to install the Wise Package Studio application
files.

User Account for Wise Server-Side Service dialog

Wise Package Studio contains a service that lets users on a client computer perform
certain operations on the Wise Package Studio server. This user account lets the service
access information it needs to perform these operations. Also, this user account
becomes the Wise Package Studio server administrator; to use the Wise Repository
Manager, you must be logged on as this user.

Note

This account is based on the NT account of the currently logged on user. If you prefer to
run the Wise service under a different account, then cancel the installation, log on with
that account, and restart the installation.

e User
(Read-only.) This defaults to the currently logged on user. It is the same as your
Windows NT login.

e Password
Enter the password of the currently logged on user.

If this password changes, you must change it in the Wise Repository Manager. See
Setting the Wise Service Account on page 48.

Web Applications dialog

Availability of the following options depends on the serial numbers you entered, whether
1S is installed, and whether the requirements for Web applications have been met.

e Destination Directory
Specify where to install files for Wise Package Studio Web applications.

e Management Reports
(Enterprise Management Server only.) This lets managers use a Web interface to
view management reports that are stored in the Software Manager database
without having installed any Wise Package Studio software on their computers.

e Preflight Data Collector and Preflight Analysis
(Quality Assurance only.) These applications are part of the Preflight Deployment
feature and are used for evaluating installations.

e Wise Web Capture
This lets repackagers capture installations on a clean machine without adding any
additional software.

If you do not install Web applications now, you can install them later. See Installing Web
Applications on page 32.

Also see Web Applications Requirements on page 9.

Ready to Install the Application dialog

Click Next to start installing.
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When the Installation Finishes

When the Wise Package Studio installation finishes, the Altiris Software Virtualization
Agent is installed if necessary. If the agent is already installed but the version is earlier
than what Wise Package Studio requires, it is updated.

If you are prompted to restart your computer, do so.

What to Do Next

e Before you can use Wise Package Studio, you must configure the repository. See
Configuring the Wise Software Repository on page 41.

e If you need to add licenses after the installation is finished, use User Licensing
Setup in Workbench. See License Management in the Wise Package Studio Help.

About the Wise Package Studio Client Installation
» Not available in Standard Edition.

In a client-server configuration, you perform a Wise Package Studio server installation
on one computer that is designated the Wise Package Studio server, and then you
perform a Wise Package Studio client installation on multiple client computers. During
the client installation, Microsoft Data Access Components (MDAC) 2.6 SP2 is installed to
allow connections to the remote databases.

You can perform a client installation silently from the command line. See Installing Wise
Package Studio Client Silently on page 31.

Two client installations are available: Local and Network. You can use both the Local and
Network client installation among members of the same team; the only requirement is
that all users designate the same share point directory.

Local Client

This installs a fully functional version of Wise Package Studio on the client computer. Do
this when network bandwidth is limited.

Network Client

This is a quick and small installation for repackagers who re-image their computers
frequently. It installs only the registry settings, .INI files, ODBC data source
connections, and shortcuts necessary to run the Wise Package Studio applications from
the packaging server. It also installs MDAC, DAO runtime, MFC support files, Test Expert
support files, and the Windows Installer runtime.

Why use the Network Client configuration?
e It minimizes changes to the client computers for repackaging.
e It simplifies and speeds installation on client computers.

e It is easier to upgrade and maintain.

Installing the Professional Edition, Client

The client installation uses the share point directory and Wise Package Studio databases
that are installed on the server. In a client installation, you can install the Wise Package
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Studio program files on the client computer, or install shortcuts and support files that
connect to the Wise Package Studio program files that are installed on the server.

You can perform a client installation silently from the command line. See Installing Wise
Package Studio Client Silently on page 31.

For help during installation, click the Help button on any dialog. For configuration
recommendations, see Configuration Best Practices on page 12.

Before the Installation

e Verify that a Wise Package Studio server installation was performed on the server
that the client will connect to.

e Verify that the Wise Software Repository was configured.

e If you will perform a Network Client installation, share the Wise Package Studio
application directory that was specified during the server installation.

Note

The Wise Package Studio installation is run from an .EXE that installs Wise Package
Studio and, in the Professional Edition, the Altiris Software Virtualization Agent. During
installation, the Wise Package Studio .MSI file is extracted to \Program
Files\Altiris\Setup Files\Wise Package Studio. The Software Virtualization Agent .MSI file
is extracted to \Program Files\Altiris\Setup Files\Software Virtualization Solution. Do not
delete these files because they are needed for future repairs.

Starting the Installation
1. Close any other applications that are running.
2. Start the installation program:
m  From a downloaded file: double-click the installation file.

m  From the product CD:

When you insert the product CD, a Welcome dialog appears. Click the button
that installs Wise Package Studio. If the Welcome dialog does not appear, use
Windows Explorer to browse to the CD, then open the file nhamed Autoplay.exe.

3. On the Welcome dialog, click Next.

4. On the License Agreement dialog, read the license terms, mark 1 accept the
License Agreement, and click Next. If you do not accept the license agreement,
you cannot continue the installation.

5. Complete the User Information dialog:

m  Serial Numbers
Click Add to display a dialog on which you can enter the serial number.

¢ Serial Number
Enter a serial number for the Professional Edition. Also enter serial numbers
for any additional modules that you might have purchased (Quality
Assurance and Enterprise Management Server).

You cannot use an evaluation serial number for the client installation if you
used a production serial number for the server installation.

¢ Previous Serial Number
If you are upgrading from a previous version of Wise Package Studio, enter
the serial number for the previous version. If you don’t know the previous
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version serial number, open Wise Package Studio and select Help menu >
About. The serial number appears on the About dialog.

m  Install Evaluation Version
Mark this to install an evaluation version without a serial number.

= Full Name, Organization
Enter this identifying information.

6. Complete the remaining dialogs, which are described below.

Wise Package Studio Evaluation dialog

This dialog appears only when you mark the Install Evaluation Version checkbox on
the User Information dialog.

Mark the option for the edition of Wise Package Studio to install. If you install the
Professional Edition, you can also mark options to include the Enterprise Management
Server module and the Quality Assurance module.

Select Installation Type dialog
Mark Client.

Wise Package Studio Client Selection dialog

e Local Client
Installs a fully functional version of Wise Package Studio on the client computer and
connects to the Wise Software Repository on the server.

e Network Client
Installs shortcuts and support files that connect to a server installation of Wise
Package Studio.

Wise Share Point Directory dialog

Specify the share point directory that was configured during the server installation.
Enter a shared network location in UNC (recommended) or mapped drive notation.
(Example of UNC: \\SERVER_NAME\WISE SHARE POINT.)

In a large enterprise with multiple teams, each team might have a different share point
directory and Wise Software Repository. After installation, you can change the repository
that a client installation connects to. See Setting Repository Preferences in the Wise
Package Studio Help.

Wise Package Studio Directory dialog

e Local client: Specify a directory on your computer. The Wise Package Studio files will
be installed there.

e Network client: Specify the same Wise Package Studio directory that was specified
during the server installation. Use UNC (recommended) or mapped drive notation.
(Example of UNC: \\SERVER_NAME\WISE PACKAGE STUDIO.) Shortcuts and
support files that connect to that location will be installed on your computer.

Ready to Install the Application dialog

Click Next to start installing.
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When the Installation Finishes

When the Wise Package Studio installation finishes, the Altiris Software Virtualization
Agent is installed if necessary. If the agent is already installed but the version is earlier
than what Wise Package Studio requires, it is updated.

If you are prompted to restart your computer, do so.

Adding Licenses After Installation

If you need to add licenses after the installation is finished, use User Licensing Setup in
Workbench. See License Management in the Wise Package Studio Help.

Installing Wise Package Studio Client Silently
> Not available in Standard Edition.

You can install the Wise Package Studio client silently from the command line, using the
following Windows Installer command line options with the installation .MSI. During the
server installation, the .MSlI is extracted to \Program Files\Altiris\Setup Files\Wise
Package Studio.

Option Description

/i Installs the product.

/qn Runs the installation with no user interface (silent
installation).

/qb Runs the installation with a basic user interface.

These options are described in the Windows Installer SDK Help, which is included in
Windows Installer Editor.

Silent Installation Properties
Property Value

SERIALS One or more valid serial numbers.

To specify multiple serial numbers, delimit them
with the pipe (]) character. Example: AAAA-
BBBB-CCCC-DDDD|EEEE-FFFF-GGGG-HHHH

MODE Client

CLIENT e Local

e Network

SHAREPOINT Valid path to the share point directory.

WPSDIR Valid path where the Wise Package Studio
application files should be installed.

For a Network Client installation, specify the
same Wise Package Studio directory that was
specified during the server installation.

Silent installations do not validate the share point directory or Wise Package Studio
directory. Be sure to specify valid paths in the command line.
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Installing the Altiris Software Virtualization Agent Silently

Wise Package Studio requires the Altiris Software Virtualization Agent (SVS Agent).
Therefore, if you install the Wise Package Studio client silently, you must include a
command line that will install the SVS Agent.

When the SVS Agent installation finishes, a reboot occurs. This is required for Wise
Package Studio and the SVS Agent to function properly.

Obtain the registration key for the SVS Agent from your server installation of Wise
Package Studio. On the server, select Start > Settings > Control Panel > Altiris SVS. The
registration key appears on the About tab of the Altiris SVS applet.

e Use the following command line when the Altiris Software Virtualization Agent is not
already installed on the client computer.

msiexec.exe /gn /i "<PATH to Software_Virtualization_Agent.msi=>"
PRODUCT_KEY=<registration key>

Warning

If you use the above command line on a computer that has the SVS Agent installed,
it will uninstall the existing agent and delete all layers. If the SVS Agent is already
installed on the computer, use the following command line instead.

e Use the following command line when the Altiris Software Virtualization Agent is
installed on the client computer. This command line updates the existing installation
of the agent.

msiexec.exe /gb- /fvamus <PATH to Software_Virtualization_Agent.msi>
PRODUCT_KEY=<registration key>

Example

The following command lines perform a silent, Network Client installation of Wise
Package Studio and the Altiris Software Virtualization Agent. In this example, the client
computer does not have the SVS Agent installed.

msiexec.exe /i "C:\WPS_7_00.msi" SERIALS="AAAA-BBBB-CCCC-DDDD"
MODE="Client" CLIENT="Network" SHAREPOINT="\\Server_Name\Wise Share Point\"
WPSDIR="\\Server_Name\Wise Package Studio\" /gn

msiexec.exe /qgn /i "<PATH to Software_Virtualization_Agent.msi=>"
PRODUCT_KEY=<registration key>

Also see About the Wise Package Studio Client Installation on page 28.

Installing Web Applications
> Not available in Standard Edition.

Wise Package Studio Web applications are: Management Reports; Preflight Data
Collector and Preflight Data Analysis; and Wise Web Capture.

Installing a Web application consists of creating a virtual directory for that Web
application. The Web applications must be installed on a Microsoft Internet Information
Services (11S) Web server on your network. You must also ensure that the other
requirements for the Web applications have been met. (See Web Applications
Requirements on page 9.)
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Wise Package Studio server), or on a different server.

Options for Installing Web Applications

When will you
install the Web
applications?

Where will you
install the Web
application?

How to install the
Web applications

During the initial
installation

On the Wise Package
Studio server (this
configuration is
typical for a single
user or small group)

See Installing the
Professional Edition,
Server on page 25.

After the initial
installation

On the Wise Package
Studio server

Install Web
applications from
Add/Remove
Programs (see
details below).

After the initial
installation

On a server with no
Wise Package Studio
programs or Web
applications

Install Web
applications from the
installation (see
details below).

After adding a new
license number for
Quality Assurance or
Enterprise
Management Server
in Workbench

On the Wise Package
Studio server or any
other server that
contains a Wise
Package Studio Web
application

Install Web
applications from
Add/Remove
Programs (see
details below).

After adding a new
license number for
Quality Assurance or
Enterprise
Management Server
in Workbench

On a server with no
Wise Package Studio
programs or Web
applications

Install Web
applications from the
installation (see
details below).

Also see Configuration Best Practices on page 12.

To install Web applications from the installation:

1. Run the Wise Package Studio installation. (For detailed instructions, see Installing

the Professional Edition, Server on page 25.)

2. On the User Information dialog, enter the Professional serial number you used for
the original server installation. If necessary, enter any other serial numbers that are
associated with the Web application you are installing (Quality Assurance, Enterprise
Management Server).

3. On the Select Installation Type dialog, mark Web.

4. On the Wise Share Point Directory dialog, specify the share point directory that was
configured during the server installation. If you specified a mapped drive during the
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initial configuration, then specify a mapped drive here. Otherwise, use UNC
notation. (Example of UNC: \\SERVER_NAME\WISE SHARE POINT)

On the Web Applications dialog, mark the checkboxes for the Web applications you
are installing.

Complete the installation.

To install Web applications from Add/Remove Programs:

When you install a Web application on a computer that already contains Wise Package
Studio programs or a Wise Package Studio Web application, use Add/Remove Programs.
Do not try to run the Wise Package Studio installation because it will perform a repair.

1.
2.

Select Start > Control Panel > Add/Remove Programs.

On the Add/Remove Programs dialog, click Wise Package Studio and click its
Change button.

The Wise Package Studio installation starts and the Application Maintenance dialog
appears.

Mark Modify and click Next.

The User Information dialog displays the serial number or numbers for the existing
installation. Accept the default serial numbers. If necessary, enter any other serial
numbers that are associated with the Web application you are installing (Quality
Assurance, Enterprise Management Server).

On the Web Applications dialog, mark the checkboxes for the Web applications you
are installing.

Complete the installation.

Starting Wise Package Studio

1.

Select Start menu > Programs > Altiris > Wise Package Studio > Wise Package
Studio.

If the Wise Package Studio Logon dialog appears, log on as instructed by your Wise
Package Studio administrator. For details, see Wise Package Studio Logon Options.
(Not available in Standard Edition.)

If you cannot log on, one or more dialogs might appear. For details, see If Your
Logon Fails.

Click OK.

The first time you start Wise Package Studio, Workbench opens to the Projects tab.
The Standard Edition opens a project named Sample Project; the Professional
Edition opens the Initial Workbench Setup project.

If Your Logon Fails

> Not available in Standard Edition.

You cannot log on to Wise Package Studio if:

You have not configured the Wise Software Repository in the Wise Repository
Manager. See Configuring the Wise Software Repository on page 41.
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e You have not been assigned a Wise Package Studio license.

m  If a serial number is available, you might be assigned a serial number
automatically. If not, the Assign User Licensing dialog appears. Mark one or
more checkboxes for the licenses to assign.

With Enterprise Management Server, you cannot be assigned a serial number
automatically. The Wise Package Studio administrator must assign licenses.

m  If a serial number is not available, the Add Serial Number dialog appears.

m  If you entered a user name from a Windows NT account, and Security Setup
does not contain a security group that matches the domain group you belong
to, you are prompted to contact your Wise Package Studio administrator.
(Enterprise Management Server only.)

Wise Package Studio Logon Options
> Not available in Standard Edition.

When a user starts Wise Package Studio, the Wise Package Studio Logon dialog appears.
Obtain your logon information from your Wise Package Studio administrator; it will be
one of the following options:

Workbench Logon

This is defined when you are assigned a Wise Package Studio license.

When to use:

e When the user does not have an Enterprise Management Server license.

e When the computer is not connected to a Windows NT domain. Example: using Wise
Package Studio on a lab computer.

What to enter on the Wise Package Studio Logon dialog:

e User name from User Licensing Setup or, with Enterprise Management Server, from
Security Setup.

e Password from Security Setup. (Enterprise Management Server only.)
e Select (Workbench Database) in Use Security From.

e Clear Always Use Current Network Login.

Current Windows NT Logon
(Enterprise Management Server and Windows NT environments only.)

When to use: To log on to Wise Package Studio as the currently logged-on Windows NT
user.

What to enter on the Wise Package Studio Logon dialog:

e Mark Always Use Current Network Login and leave the remaining fields blank.

When the user starts Wise Package Studio in the future, they will be logged on
automatically.

Windows NT Account

(Windows NT environments only. The Workbench database must contain at least 1
Enterprise Management Server license.)
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When to use: To log on to Wise Package Studio with a Windows NT account. This account
can be different from the one that is currently logged on to Windows. This lets users log
on to Wise Package Studio from someone else’s computer or from a remote computer.
The computer must have Wise Package Studio installed.

What to enter on the Wise Package Studio Logon dialog:

e Windows NT user name from the Windows NT domain.

e Password from the Windows NT domain.

e Select the Windows NT domain name in Use Security From.

e Clear Always Use Current Network Login.

Note

When a user logs on with a Windows NT account, or when they use the current network
logon, Security Setup must contain a security group whose name matches a valid group
in the NT domain, and the user must be defined in that domain group. If a user is in
multiple NT groups, they are logged on under the first valid group encountered.

Registering Your Software

It is very important that to your software. Registering qualifies you to receive technical
support via newsgroups and e-mail, plus notifications about future product upgrades. To
register:

1. Connect to the Internet.
2. Do either of the following:
m  In Workbench, select Help menu > Wise on the Web > On-Line Registration.

m  In your browser, go to www.wise.com/product_registration.asp.
Your browser opens to the Product Registration page on the Wise Web site.

3. Click the Wise Technical Support Center link on the Web page and create a new user
profile or log onto an existing user profile.

4. Follow the instructions on the Web page to complete the registration.

Converting an Evaluation Version to a Production
Version

You can convert an evaluation version of Wise Package Studio to a production version
without uninstalling the product.

1. Purchase the product and obtain a production serial number.
2. Start Wise Package Studio.

m  If the evaluation period has not expired, then when the Wise Package Studio
Evaluation dialog appears, click Serial Number. The Add Serial Number dialog
appears.

m  If the evaluation period has expired, and a production serial number is not
available, the Add Serial Number dialog appears.
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m  If the evaluation period has expired, and a production serial number is
available, you are assigned a serial number and logged on.

This happens when someone adds production serial numbers to an evaluation
version of Wise Package Studio. In that case, all evaluation licenses expire.

3. On the Add Serial Number dialog, enter a production serial number and click OK.

The evaluation version is converted to a production version. The next time you start
Wise Package Studio, the evaluation dialog no longer appears.
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Chapter 3
Managing the Wise Software Repository

> Not available in Standard Edition.

The Wise Repository Manager gives you control over database configuration and
updates, and lets you see the changes that are made by database updates. The Wise
Repository Manager provides a view of the Wise Software Repository and lets you
perform the following tasks:

e Configuring the Wise Software Repository, which consists of the Wise share point
and the databases that are associated with it.

e Upgrading Databases.

e Changing Database Settings.

e Creating Software Manager Databases.

e Creating a New Repository.

e Opening a Repository to upgrade it or make it the default.

e Choosing a Revision Control System.

e Setting the Wise Service Account.

The Wise Repository Manager is available on the Wise Package Studio server only.

Procedures in this section assume that you are familiar with creating databases and
registering ODBC data sources. We do not offer technical support for MSDE or SQL
Server. If you need help, ask your database administrator.

Caution
Do not modify Wise Package Studio databases outside of the Wise Repository Manager.

Additional topics include:

e About the Wise Software Repository.

e Starting the Wise Repository Manager.
e The Wise Repository Manager Interface.

e Repository Configuration Dialogs.

About the Wise Software Repository

> Not available in Standard Edition.

The Wise Software Repository™ is a collection of software packages, resources and
information about those resources, project management information, and quality
assurance data used by organizations as part of the repackaging process. This scalable
repository provides a centralized point for managing software packages at any stage of
deployment.
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The Wise Software Repository consists of:

e Share point directory
Contains shared Wise Package Studio files and shared resources that are used to
create Windows Installer installations. It also contains source files for packages in
the Software Manager database. All Wise Package Studio databases are associated
with a specific share point directory.

e Workbench database
Stores information that Wise Package Studio creates and uses. Examples: project,
process, tool, and security information. A repository can contain only one
Workbench database.

e Software Manager database
Contains all software packages and other resources that are used by an
organization. Other resources include: merge modules, device drivers, Group Policy
Objects, and standard operating system environment snapshots. A repository can
contain multiple Software Manager databases.

e \Wise Services database
(Formerly named Preflight database.) Stores the following data that is generated
and used by Wise services:

m  Tasks that are managed by the Wise Task Manager. Examples: importing
packages; running the Merge Modules Wizard; compiling .MSI or .WSI packages
in Software Manager; remotely compiling packages in Windows Installer Editor.

m  (Quality Assurance module only.) The results that are generated from deploying
preflight packages, which are made with Package Instrumentation. These
results are used by the Preflight Data Collector and Preflight Analysis Web
applications.

A repository can contain only one Wise Services database.

Multiple Repositories

e In a large enterprise with multiple teams, each team might use a different share
point directory and Wise Software Repository. Because a Wise Package Studio
server can be associated with only one active repository at a time, each team must
install their repository on a different server.

e Asingle Wise Package Studio server can contain multiple repositories. However, only
one repository can be active at a time.

To change the active repository on a Wise Package Studio server, open the repository in
the Wise Repository Manager.

A Wise Package Studio client can connect to any Wise Software Repository that it can
access. To change a client’s default repository, use the Workbench Preferences dialog >
Repository tab and specify the share point that is associated with an active Wise
Software Repository.

Starting the Wise Repository Manager
> Not available in Standard Edition.

Requirements

To use the Wise Repository Manager:
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e You must be logged on to a computer that contains a Wise Package Studio server
installation.

e You must be logged on as the Wise Package Studio server administrator, that is, the
user account under which Wise Package Studio was installed.

To start the Wise Repository Manager:

After Wise Package Studio is installed, select Start menu > Programs > Altiris > Wise
Package Studio > Wise Repository Manager.

If the Wise Software Repository has not been configured, the Create New Repository
wizard starts.

For details on the Create New Repository wizard, see Repository Configuration Dialogs
on page 45.

Also see:

The Wise Repository Manager Interface on page 40
Configuring the Wise Software Repository on page 41
Upgrading Databases on page 42

Changing Database Settings on page 43

Creating Software Manager Databases on page 44
Creating a New Repository on page 44

Opening a Repository on page 45

Choosing a Revision Control System on page 47
Setting the Wise Service Account on page 48

The Wise Repository Manager Interface

> Not available in Standard Edition.

When the Wise Repository Manager opens, it displays the current repository.

Wise Repository Manager Left Pane

=m Databases
=5 workbench
B¢ workbench Database
i) Software Manager
B Software Manager Database <—Database needs to be
Subscriptions updated
&) Wise Services
EI Wise Services Database
1 Revision Control
[ wise Service

The left pane contains a tree structure that represents:

e The databases that comprise the Wise Software Repository. If the repository
contains multiple Software Manager databases, the default is displayed in bold type.
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Note
The Subscriptions subfolder displays any databases that are subscribed to from the
selected Software Manager database. To manage a subscribed database, open the
repository that it is associated with.

e Pages that contain settings for Revision Control and the Wise Service account.

Click the top-level folder or a database icon to display help in the right pane.

Click a specific database (in bold type) to display maintenance options in the right pane.

Wise Repository Manager Right Pane

Describes what the selected action

does
TACtiDnS: - ) U*de Wersion:
D atabase Action Status
Q Upgrade to Baseline Pending Description:

ADPKE}' Pend!ng Upagrades the database to version 5.60

Unicode Pending

FegExport Pending

Upgrade Pending

Upgrade Module Signa... Pending Dietail:

Upgrade File Language: Pending
Upgrade Formatted Stri..  Pending
Upgrade File Hazhes Pending
Upgrade File Times Pending

A A

Wiseddmin

[ R ][ Runan

Upgrade actions and Lists the SQL scripts or command lines
their statuses that the selected action runs

In the right pane, you can:
e Upgrade the database to a new version. See Upgrading Databases on page 42.
e Display a record of completed upgrade actions by clicking Show Log on the toolbar.

e Change the database settings. See Changing Database Settings on page 43.

Configuring the Wise Software Repository

> Not available in Standard Edition.

After you install or upgrade Wise Package Studio, you must configure the Wise Software
Repository. This consists of defining:

e The share point directory.
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e The location of the various Wise Package Studio databases.

e The authentication method for each database.

To configure the Wise Software Repository:

1. Access the Wise Repository Manager. See Starting the Wise Repository Manager on
page 39.

If the Wise Software Repository has not been configured, the Create New Repository
wizard starts.

2. Step through the Create New Repository wizard. For details, see Repository
Configuration Dialogs on page 45.

3. If you have upgraded from a previous version of Wise Package Studio, upgrade the
databases. See Upgrading Databases on page 42.

Upgrading Databases

> Not available in Standard Edition.

When you upgrade Wise Package Studio, you must also upgrade the Wise Package
Studio databases before you can use them with the new version. You do this in the Wise
Repository Manager.

Do this after you configure the repository with the Create New Repository wizard.

The B¢ icon next to the database name in the left pane indicates that the database must
be upgraded before it can be used. When the red X is removed from the icon, you can
safely use that database with the current version of Wise Package Studio. This can occur
before all upgrade actions have been completed. That is because the upgrade might
contain background actions that do not have to be completed before users can begin
using Wise Package Studio.

To review the changes that the upgrade will make, click an action in the Actions list.
Information about what that action does is displayed in the Description and Details
sections. The Upgrade to Baseline action upgrades databases earlier than version 5.6 to
a baseline format, from which you can upgrade to 6.0 or any later version. (The baseline
version that appears in the action’s description does not necessarily correspond to any
product version number.)

Note

If you are upgrading a repository that contained multiple Software Manager databases,
or if one of the databases had a name other than the default name, register and
upgrade those databases separately. See Registering a Database on page 43.

To upgrade the entire repository:
On the Wise Repository Manager toolbar, click Upgrade.

This upgrades all databases that require upgrading.

To upgrade one database at a time:

1. In the left pane of the Wise Repository Manager, click a database name (in bold
type).
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2. Do either of the following:
m  To run all uncompleted actions, click Run All.

m  To run the upgrade actions individually, click the first uncompleted action in the
list and click Run. (Uncompleted actions are indicated by a status of Pending.)
Then repeat for subsequent actions. You cannot run the actions out of
sequence.

When the upgrade is complete:

The database or databases are updated, the actions you ran are marked as completed,
and a record of the upgrade actions is written to WiseAdmin.log. To display the most
recent log, click Show Log on the toolbar.

Registering a Database
> Not available in Standard Edition.

Do this when you upgrade a repository that contains multiple Software Manager
databases. During the Create New Repository wizard, you can specify only one Software
Manager database. Therefore, the other Software Manager databases are not
registered.

To register a database:

1. In the left pane of the Wise Repository Manager, click the Software Manager icon.
2. On the toolbar, click Register.

The Select Data Source dialog appears. This is a standard Windows ODBC
connection wizard, which lets you connect to a database via an ODBC data source.

3. Connect to the database. If you need help, ask your database administrator.
The database appears in the left pane of the Wise Repository Manager.

4. Upgrade the database. See Upgrading Databases on page 42.

Changing Database Settings

> Not available in Standard Edition.
You can change logon settings for a Wise Package Studio database from the Wise
Repository Manager.
1. In the left pane of the Wise Repository Manager, click a database name (in bold
type).
2. Click Settings in the lower right of the right pane.
The Change Database Settings wizard starts.
3. Complete the following dialogs:
m  Database Administrator Logon Information dialog

m  Database Service Logon Information dialog
See Repository Configuration Dialogs on page 45.
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Creating Software Manager Databases

> Not available in Standard Edition.

If you plan to import a large number of packages, you might use multiple Software
Manager databases to reduce the size of the individual databases. Use the Wise
Repository Manager to create Software Manager databases.

The ability to create a database is disabled for the Workbench and Wise Services
databases because a repository can contain only one of each of those databases.

This procedure assumes that you are familiar with creating databases and registering
ODBC data sources. We do not offer technical support for MSDE or SQL Server. If you
need help, ask your database administrator.

1. In the left pane of the Wise Repository Manager, right-click the Software Manager
icon and select Create New Database.

The Create New Database wizard starts.
2. Complete the following dialogs:
m  Database Identification dialog
m  Database Administrator Logon Information dialog

m  Creation Options dialog
See Repository Configuration Dialogs on page 45.
3. To make this the default Software Manager database, right-click the database name

in the left pane and select Set as Default. The default database name is displayed in
bold type.

To provide an additional level of security, your database administrator can set
permissions on tables in the new Software Manager database. This is not required, but is
an option if you are concerned about unauthorized users changing database tables
outside of Wise Package Studio. For recommendations, see Setting Database Security in
the Wise Package Studio Help.

Creating a New Repository

> Not available in Standard Edition.

When you create a new Wise Software Repository, all links to the old repository are
broken, but the data is not deleted. The new repository becomes the default for all Wise
Package Studio clients that connect to this server.

1. In the Wise Repository Manager, select File menu > New.
The Create New Repository wizard starts.

2. Complete the dialogs that appear. When you are asked to specify the share point
directory, specify a share point path that resides under an existing location. See
Repository Configuration Dialogs on page 45.

The new databases are created and associated with the share point directory you
specified.

To provide an additional level of security, your database administrator can set
permissions on tables in the new databases. This is not required, but is an option if you
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are concerned about unauthorized users changing database tables outside of Wise
Package Studio. For recommendations, see Setting Database Security in the Wise
Package Studio Help.

Opening a Repository
» Not available in Standard Edition.

In a large enterprise with multiple teams, each team might use a different Wise
Software Repository. However, a Wise Package Studio server can be associated with only
one active repository at a time. To change the default Wise Software Repository for a
server installation, open a new repository.

Note

To change the default repository for a client installation, use the Workbench Preferences
dialog > Repository tab and specify the share point that is associated with an active
Wise Software Repository. See Setting Repository Preferences in the Wise Package
Studio Help.

If you upgrade from a previous version of Wise Package Studio that has multiple
repositories, only one repository is upgraded. To upgrade the other repositories, you
must open them and then upgrade them.

1. In the Wise Repository Manager, select File menu > New.

2. On the Wise Share Point Directory dialog, specify the share point that is associated
with the repository you are opening and click Next.

m  If the repository associated with that share point is at the current version, it
opens in the left pane.

m  If the repository associated with that share point has not been upgraded,
additional dialogs appear. Complete the dialogs to configure the repository, and
then upgrade the database. See Repository Configuration Dialogs on page 45
and Upgrading Databases on page 42.

Repository Configuration Dialogs

> Not available in Standard Edition.

All or some of the repository setup dialogs appear when you:
e Configure the repository as part of a new or upgrade installation.
e Change database settings. See Changing Database Settings on page 43

e Create a new Software Manager database. See Creating Software Manager
Databases on page 44.

e Create a new repository. See Creating a New Repository on page 44.

e Open an existing repository that has not been upgraded. See Opening a Repository
on page 45.

Wise Share Point Directory dialog

The share point directory stores data that can be shared by team members.
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Specify a shared network location. Your entry is converted to UNC notation. This
directory is created and shared for you.

If you are creating a new repository after the initial installation, you must specify a
share point path that is shared.

Valid paths for a new share point:

C:\Wise Share Point 2
\\server\c$\Wise Share Point 2

Invalid path for a new share point: \\server\Wise Share Point 2

Note

When you perform a server installation in a team environment, we recommend that you
install the share point directory on the same physical drive that contains the Wise
Package Studio application files.

File Share Name dialog

The share point directory must be accessible by other computers. Enter the name of the
file share to associate with the share point directory.

Database ldentification dialog

When you create a new repository, this dialog appears for each database that you are
defining. When you change a database’s settings or add a Software Manager database,
this dialog appears for that specific database only.

e Database Name
Specify the database name to create or connect to. If you are creating an additional
database, use a unique name. Example: Software Manager Database 2.

If you are upgrading from a previous version, do not accept the default name if the
existing database has a different name. Enter the exact name of the existing
database.

Note
If you are upgrading from a version earlier than 6.0, the Wise Services database is
named Preflight. The upgrade process will not change this name.

e Server
Select the database server for the database you specified.

Database Administrator Logon Information dialog

When you create a new repository, this dialog appears for each database that you are
defining. When you change a database’s settings or add a Software Manager database,
this dialog appears for that specific database only. For recommendations on which
authentication method to use, see Authentication Best Practices on page 20.

Specify the logon information for a database administrator (DBA) for the selected
database server:

e Windows NT authentication using your current logon credentials
This is the preferred option for the Wise Services database, if you will use the
Preflight Deployment feature.

e SQL Server authentication using a DBA login and password
When you select this, enter a valid Logon ID and Password.
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Define how user names and passwords should be validated:
e Windows NT authentication using the user’s Windows logon credentials

e SQL Server authentication using a logon ID and password supplied by the
user
When you select this, you must create users. Do this on the Create New Users
dialog. If users will log on with the DBA credentials, you do not have to create users.

Database Service Logon Information dialog

This dialog appears only when you change an existing database’s settings.

This account is used to access this database from various background processes
(examples: package import, the upgrade process). The initial Wise Package Studio
installation creates this account and generates a random password. If you prefer to
manage this password yourself, you can change it here. The password you enter will be
encrypted.

Create New Users dialog

This dialog appears if you specify SQL Server authentication for users. The DBA logon
information you entered earlier will be used to create database users that you specify on
this dialog for all databases that are being created (Workbench, Software Manager, Wise
Services). These users will have modification privileges in all databases.

For each user, enter a User Name and Password and click Add.

Creation Options dialog

If the database is not local or the database already exists (example: during an upgrade),
this dialog does not appear.

e Import sample applications into Software Manager
Import packages for sample applications into the Software Manager database. This
option lengthens configuration time.

Choosing a Revision Control System

> Not available in Standard Edition.

Wise Package Studio contains a Revision Control System, with functions available in
Software Manager. Use Revision Control to:

e Protect packages from unauthorized changes and changes to multiple copies of a
package at one time.

e Track changes to packages.

Revision Control performs standard source control functions, including: check in, check
out, undo check out, and view and retrieve previous versions. Whereas other source
control products protect source files used to compile packages, Revision Control protects
packages.

For details, see Revision Control in the Software Manager Help.

You cannot use both the Wise Revision Control System and a third party source control
product. Choose which system to use in the Wise Repository Manager.
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To choose a revision control system:

1. In the left pane of the Wise Repository Manager, click the Revision Control System
icon.

2. In the right pane:
m  To use the Revision Control System in Wise Package Studio:
¢ Mark Wise Revision Control System.

¢ Mark Require Comments for Each Revision to require users to enter
comments each time they check a package back into Revision Control.

m  To use a third-party source control product, mark External Revision Control
System.

The Source Control menu in Windows Installer Editor provides access to the
external revision control system.

Also see Starting the Wise Repository Manager on page 39.

Setting the Wise Service Account

> Not available in Standard Edition.

Wise Package Studio contains a service that lets users on client computers perform
certain operations on the Wise Package Studio server. By processing operations on the
server, you reduce the workload of the client computer and, if the packages and
databases reside on the server, you improve the operation’s performance.

This service requires a user account to access the information it needs to perform these
operations. This user account is set up when Wise Package Studio is installed on the
server. If the password for the user account changes, then this service will not work until
the user’s password is updated in the Wise Repository Manager.

To update the user account password:

1. In the left pane of the Wise Repository Manager, click the Wise Service icon.

2. In the right pane, change the password of the user account that is displayed.

Also see Starting the Wise Repository Manager on page 39.
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» Professional Edition.
This tutorial uses features that are not available in the Standard Edition of Wise Package
Studio.

This tutorial guides you through the process of repackaging an application into Windows
Installer format. You use a sample application named QuickFacts, which is included with
Wise Package Studio, to provide you with a realistic practice scenario. QuickFacts is a
utility that displays facts and bitmaps. It was created to illustrate the repackaging
process.

In this tutorial, you will:

e Create a new Wise Package Studio project.

e Use SetupCapture to recreate the existing installation in Windows Installer format.
e Customize the installation package in Windows Installer Editor.

e Verify that the package complies with standards.

e Test the repackaged installation.

e Detect and resolve conflicts in ConflictManager.

e Deploy the application to end users.

If you are using Enterprise Management Server, security settings can limit access to
some features. See your manager or system administrator if a feature described in this
tutorial is not available.

Note
This tutorial does not cover details of the Wise Package Studio tools. Press F1 on any
window or dialog for context-sensitive help.

Before You Start

e Make sure you are using the Professional Edition. This tutorial uses features that are
not available in the Standard Edition.

e Obtain Wise Package Studio logon information.

m  If you are using an evaluation version of Wise Package Studio, you can log on as
Admin and leave the password blank.

m  If you are using a production version, ask your manager or Wise Package Studio
administrator for logon information.

e Close other applications before starting this tutorial. During the repackaging
process, you capture the actions performed by an installation; it is important to
close all applications other than Wise Package Studio to avoid capturing the
activities of other applications and processes.
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This tutorial assumes that you are installing the sample application, QuickFacts, on
your computer for the first time. If you have installed QuickFacts on your computer,
uninstall it and remove any files and registry keys related to it. Files left from
previous installations can cause your results to deviate from the information
presented in this tutorial.

Import a Sample Package into Software Manager

In this procedure, you import a sample package into the Software Manager database.
Later in the tutorial, you will detect conflicts between this sample package and the new
package you create.

Frequently, you will need to import a package into the Software Manager database
without repackaging. You might do this with a package that has already been approved
and deployed so that all packages that have been installed throughout your company
are in the Software Manager database.

To import a sample package into Software Manager:

1.

Select Start menu > Programs > Altiris > Wise Package Studio > Wise Package
Studio.

The Wise Package Studio Logon dialog appears.

Enter your logon information and click OK.

Wise Package Studio opens.

Click the Tools tab. At the top of the Tools tab, double-click Software Manager.
Software Manager opens.

Select Packages menu > Import.

The Import Type dialog appears.

Mark Import a single file into the Software Manager database and complete
the dialog:

m File
Browse to the Tutorial subdirectory under the Wise Package Studio directory
and open Sample Conflict.msi.

m  Distribute source files to the share point directory
Mark this checkbox to copy the package’s source files to the share point
directory.

m Overwrite existing application and package
Mark this checkbox to overwrite any package that is already in the database
with the same application and package names.

m Do not modify the original package
Normally, when you import a Windows Installer installation (.MSI or .WSI), the
original installation file is updated with Wise-specific version information that
speeds future subscriptions and imports of the installation. Mark this to prevent
the original file from being changed.

m  Perform this operation on the Wise Package Studio Server
Clear this checkbox.
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m  Add to Revision Control
Clear this checkbox.

m  Detect conflicts during package import
Clear this checkbox.

6. Click Next on the Import Type dialog.
The Package Details dialog appears.
7. Complete the Package Details dialog:

m  Application Name
Enter Sample Conflict. This identifies the application in the Software Manager
database.

m  Package Name
Enter Conflict 1.0. Typically, you use the application name plus specific version
information as the package name.

m  Use Transactions for Import
Leave this checkbox cleared.

8. Click Next on the Package Details dialog.

The Transforms and Patches dialog appears.
9. Click Finish.

The Wise Task Manager appears, then closes.

The package you selected is imported into the Software Manager database. It
appears in Software Manager’s Applications/Packages pane.

10. Close Software Manager.
The right pane in Workbench reappears.

You have finished importing a package into the Software Manager database. Next, you
will create a new project in Wise Package Studio.

Create a New Project

In this procedure, you create a new project named QuickFacts in Wise Package Studio.
The project defines the name and location of files, as well as the project name and other
information. You also assign a repackaging process to the project. This process contains
tasks that you will complete as you follow this tutorial. The tasks guide you through the
basic steps of repackaging. All tasks automatically access the appropriate project files.

Note
Follow the instructions exactly as presented, otherwise your results can deviate from the
information presented in this tutorial.

To create a new project:
1. If Wise Package Studio is not open, open it and log on.
2. Select File menu > New Project.

The Project Setup dialog appears. A new project appears in the Project list on the
left and is selected by default.
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3. Complete the right pane:

Project Name
Enter: QuickFacts

Project Directory
Leave the default.

Status
Leave the default of Open.

Product Vendor
Select Altiris.

Application Name
Enter: QuickFacts

Package Name
Enter: QuickFacts version 3.0

File Name
If a default does not appear, type: QuickFacts

Vendor Package

Do not type in this field. Instead, click the __] button next to the field. Navigate
to the Tutorial subdirectory under the Wise Package Studio directory and open
QuickFactslInstall.exe.

Project Owner
This field appears with Enterprise Management Server only. Leave the default.

Process

Select Repackage for Windows Installer. The Repackage for Windows
Installer process contains the tasks for repackaging an installation into a
Windows Installer package.

4. On the Project Setup dialog, click Close.

5. If the Projects tab is not displayed in the left pane of Wise Package Studio, click it.

6. From Active Project, select QuickFacts.

The Projects tab displays the process you’ll follow to repackage the QuickFacts
application. This process consists of a set of tasks that appear in the Task list.
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DD & EEAN S

Projects | Tools

Active Project: | QuickFacts The Active Project is the one

: | you are currently working on.
Tazk Tool
Application Integration -
[T Create package Bun
[T Edit package Bun
Package Testing
[T Validate compliance with standards Bun
| Test package Bun
T Distribute to share point directory Fun
I Import into Software Manager database  Flun | Process, made up of tasks.
ITT  Resolve conflicts Fiun You'll follow these tasks to
|1 Prepare package for deployment testing — Fun repackage the sample
T Deplay instumented package application.
[T Analyze Results Biun
Releage Management
I Make package available Fun
T Distribute package Fun | _|

Note

If a task is disabled, it means that you do not have a license to use the tool associated
with it. With Enterprise Management Server, it might also mean that you do not have
permission to use the tool associated with the task or have not been assigned as the
task’s owner.

You have finished creating a new project. Next, you will create a new package by
capturing the QuickFacts installation.

Create the Package with SetupCapture

In this procedure, you repackage the existing QuickFacts installation program, which is
the first step in the Application Integration phase. The Create package task runs
SetupCapture, which records an installation and recreates it in Windows Installer Editor.
SetupCapture also copies the directory structure and source files of the installation to
the Projects\QuickFacts subdirectory in your share point directory. The repackaged
installation that results from this SetupCapture will reference the source files in your
share point directory rather than those installed in the Program Files directory.

Before you follow this procedure, you must have created the project as described in
Create a New Project on page 51.

Note

Normally, you perform SetupCapture on a clean machine, which represents the base
computer for your organization, and you reboot during the capture. However, in this
tutorial, the installation you are capturing does not require a clean machine or a reboot.

To create the package with SetupCapture:

1. Close all applications other than Wise Package Studio. This includes background
applications that might create or change files on the computer. (Example: Norton
AntiVirus.)
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2. In Wise Package Studio, click the Projects tab. QuickFacts should appear in the
Active Project drop-down list.

3. Click the Run link next to the Create package task.
The Welcome dialog appears.

4. Click Settings.
The SetupCapture Configuration dialog appears.

5. Set .TMP files to be excluded.
a. Click the File and Folder Exclusions tab.

b. If a message about file exclusions located under your user profile appears, click
Yes.

c. Click Add on the File and Folder Exclusions tab.

d. The File Exclude dialog appears.

e. Leave the Directory field blank.

f. In File/Wildcard, enter *.tmp and click OK on the File Exclude dialog.

This adds *.tmp to the list of files that SetupCapture will ignore when it
captures an installation.

6. On the Directories to Watch tab, note the drive letter that will be watched so that
you can install QuickFacts to this drive later in the tutorial.

7. Click OK on the SetupCapture Configuration dialog.
The Welcome dialog reappears.
8. Click Next on the Welcome dialog.
The Capture Methodology dialog appears.
9. Complete the Capture Methodology dialog:
m  Mark Snapshot.
m  Clear Use SmartMonitor in conjunction with Snapshot.

m  Click Next.

Note
Snapshot comparisons look at the difference between a “before” snapshot of the
system and an “after” snapshot to determine what happened during the installation.

What happens next depends on whether SetupCapture previously scanned your
computer.

m  If SetupCapture previously scanned your computer, the Initial Scan dialog
appears.

m  If SetupCapture did not previously scanned your computer, SetupCapture skips
the Initial Scan dialog.

10. If the Initial Scan dialog appears, mark Rerun the initial scan and click Next.
The Begin Installation Capture dialog appears.

11. Click Next on the Begin Installation Capture dialog.
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SetupCapture scans your computer; this might take several minutes. When the scan
finishes, the Execute Installation dialog appears. The vendor package that you
specified in the QuickFacts project appears in the .EXE Name field. This is the
installation that you will capture.

Click Execute on the Execute Installation dialog.

The QuickFacts Setup program opens in front of SetupCapture.

Step through the QuickFacts Setup program, accepting all default settings.
This installs a sample application named QuickFacts on your computer.

When the QuickFacts installation finishes, click Next on the Execute Installation
dialog.

The End Installation Capture dialog appears.
Click Next on the End Installation Capture dialog.

SetupCapture scans your computer for a second time to determine what changed.
This might take several minutes. When the scan finishes, the SetupCapture
Inclusions dialog appears, which lists all the files, registry entries, shortcuts, and
.INI file changes that will be included in the repackaged installation.

Note

Typically, you exclude from your installation those files and registry entries that are
not applicable to all computers, or are not applicable to Windows Installer
technology. Additional files that are not related to QuickFacts might be included in
the list. Examples: temporary Internet files, cookies, and files that have to do with
software that runs constantly in the background, such as virus protection software.

Exclude all files except the QuickFacts files listed below.

License.txt
QckFacts.exe
ReadMe.txt
Birds.bmp
Birds.qft
Cats.bmp
Cats.gft
Dogs.bmp
Dogs.qgft
QuickFacts.cnt
QuickFacts.hlp
QFGUITAM.dII

17. Select Registry keys from Inclusion Type and exclude all registry keys except:
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m  Those with QuickFacts or QckFacts in their Key name.

m  Registry keys for file associations, which vary by operating system. The list
should include registry keys with the following ValueNames:

CaptionFontName
FactsBkColorBlue
FactsBkColorGreen
FactsBkColorRed
TitleFontSize
TitleText
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Note

When you become familiar with your particular operating system environment, you
will more easily know what files and registry entries are extraneous to an
application. You can also run SetupCapture Configuration to build an exclusion list to
further reduce extraneous files and registry entries.

18. Click Next on the SetupCapture Inclusions dialog.

The SetupCapture Exclusions dialog appears, which shows the registry keys that will
be excluded from the repackaged installation.

Change Exclusion Type to Files to see the files that are excluded. There might be
additional files and registry keys other than those you excluded if you have
previously run/configured SetupCapture or if they are in the default SetupCapture
exclusion list. Example: The files INSTALL.LOG and Unwise.exe appear because they
are in the default SetupCapture exclusion list.

19. Click Next on the SetupCapture Exclusions dialog.
The Finish dialog appears.

20. The fields should appear exactly as shown below, if the Program Files directory is
located on your C: drive. If the fields do not appear as below, edit them.

W SetupCapture

Finizh ﬁ

The SetupCapture iz now complete. You can specify the product detailz below. Click the Finish button
to save this installation.

Mame: i'QuickFaCtS ]
Wersion: 30 . )
b arufacturer: B -i

Default Directory:

Select a feature from the list below or create a new feature that will contain this installation information.

Destination Feature: :Z|:|r|'||:|lr3te New

< Back “ Finish ][ Cancel

21. Click Finish.
22. If the Files in Repository dialog appears, click OK.

This saves the captured installation in Windows Installer format and copies the directory
structure and source files of the installation to the Projects\QuickFacts subdirectory of
your share point directory. This lets you create and edit your QuickFacts.msi package
using relative paths, independent of the original installation.

You have finished capturing the QuickFacts installation. On the Projects tab, the
checkbox next to the Create package task is marked to indicate that the task is
complete. Next, you will customize the QuickFacts installation.
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Edit the Package in Windows Installer Editor

In this procedure, you open the QuickFacts installation package you captured in the
previous procedure, and then customize it for your organization. The Edit Package task
runs Windows Installer Editor, which is an installation development environment for
Windows Installer.

Windows Installer Editor has 3 views: Installation Expert, MSI Script, and Setup Editor.
Each view provides a different development environment. In this tutorial, you use
various pages in Installation Expert. Each page lets you review and edit a specific aspect
of your installation.

Before you follow this procedure, you must have completed the previous procedure in
this tutorial—Create the Package with SetupCapture on page 53—as well as all
preceding procedures.

To edit the package in Windows Installer Editor:

1. Make sure you are in Wise Package Studio with the Projects tab selected and
QuickFacts selected in the Active Project drop-down list.

2. Click the Run link next to the Edit package task.

The repackaged QuickFacts installation (QuickFacts.wsi) opens in Windows Installer
Editor.

3. Make sure you are in Installation Expert by clicking the Installation Expert tab at the
lower left of the window.

Note

Along the left side of the window are page group headings (example: Project
Definition), below which appear linked page names. Click a page group name
(example: Project Definition) to expand or collapse it. Click the page names below
the page group names to go to a particular page.

4. In the Project Definition page group, click Product Details.

The Product Details page appears, which contains the installation’s meta data.
Because you entered much of the required information during SetupCapture, most
of the fields are populated.

Enter the information that is not populated:

m Application
Enter: QuickFacts

m  Package
Enter: QuickFacts version 3.0

m  Product Type
(Read-only)

m  Product Name
QuickFacts

m  Manufacturer
Altiris.

m Version
3.0

Wise Package Studio Getting Started Guide 57



Tutorial

m  Default Directory
Program Files\QuickFacts

m  Package Path
(Read-only)

m  Product Code
Leave the default. This is a unique code, called a GUID, that Windows Installer
uses to identify the product.

m  Target Platform
(Read-only.)

m  Application Type
Make sure this is set to Win32 (non .NET).

m  Installation Target
Make sure this is set to Windows-based desktop/server PC.

m Description
(Optional.) Enter: This is a sample application

(Optional.) In the Project Definition page group, complete the General Information
page and the Add/Remove Programs page. To display context-sensitive help on
these or any other Installation Expert pages, press F1.

The information on the General Information page appears if an end user right-clicks
on the installation .MSI in Windows Explorer and selects Properties. The information
on the Add/Remove Programs page appears in the Add/Remove control panel for
QuickFacts (Windows 2000 or later only).

In the Project Definition page group, click Features.
The Features page appears.
Expand the Complete feature tree.

A subfeature, named Feature, appears under the Complete feature. The
QckFacts.exe file and its advertised shortcut are isolated in a separate feature to
avoid a common performance issue related to Windows Installer repair functionality.
The issue can cause repeated attempts to repair the application. Isolating the
advertised .EXE and its shortcut fixes the problem. By default, the feature named
Feature is hidden from the end user.

On the Features page, rename Feature to MainApp:

a. Double-click the word Feature in the feature tree.
b. The Feature Details dialog appears.

c. In both the Name and Title fields, type: MainApp
d. Leave the defaults in the remaining fields.

e. Click OK on the Feature Details dialog.

In the Feature Details page group, click Files.

The Files page appears and the files for the MainApp feature are displayed. To see
the files for the Complete feature, select Complete from the Current Feature
drop-down list at the top of the page. The Current Feature drop-down list indicates
the number of files in each feature. In the lower-left list box, expand the QuickFacts
folder to see the directories for that feature. The files in each directory are displayed
in the lower-right list box.
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(Optional.) Review the shortcuts and registry entries by selecting the Shortcuts and
Registry pages in the Feature Details page group. Only the shortcuts or registry
entries for the current feature appear. If no entries appear, change the current
feature by selecting the feature name in the Current Feature drop-down list at the
top of the page.

In the Target System page group, click System Requirements. You might have to
scroll down to see the Target System page group.

The System Requirements page appears, where you change the system
requirements of this installation:

a. Double-click the Windows Version requirement.

b. On the Minimum System Requirements dialog, select Windows 98 from
Windows Version. This allows the program to install on Windows 98 or later.

c. In Message Text, enter:
You must have Windows 98 or later to run this installation.
d. Click OK on the Minimum System Requirements dialog.

e. Leave the Windows NT requirement set to All Versions, which includes
Windows NT 4.0, Windows 2000, and later.

In the User Interface page group, click Dialogs.

The Dialogs page appears, where you specify which dialogs appear, and you specify
a ReadMe file to display:

a. Turn off the User Information dialog by clearing its checkbox.
b. Turn on the Readme dialog by marking its checkbox.

c. Select the Readme dialog and click Import Text, which is to the right of the
dialog preview.

d. On the Open dialog, navigate to share point\Projects\QuickFacts\Program
Files\QuickFacts, where share point is the path to your share point directory.
This is the location of the source files for this package, which were copied during
SetupCapture. Change the Files of type drop-down list to Text files (.txt).
Open the ReadMe.txt file.

The ReadMe text appears in the Readme Information dialog preview and will
appear in this dialog during installation.

Save the installation by selecting File menu > Save.

14. Close Windows Installer Editor.

You have finished customizing the QuickFacts installation, which completes the
Application Integration phase of the Repackaging for Windows Installer process. On the
Projects tab, the checkbox next to the Edit package task is marked to indicate that the
task is complete. Next, you will validate the package you created.

Package

In this procedure, you validate the QuickFacts package, which is the first step in the
Package Testing phase. The Validate compliance with standards task runs Package
Validation, which verifies that the package complies with Microsoft’s Application
Specification for Windows 2000.
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Before you follow this procedure, you must have completed the previous procedure in
this tutorial—Edit the Package in Windows Installer Editor on page 57—as well as all
preceding procedures.

To validate the package:

1. Make sure you are in Wise Package Studio with the Projects tab selected and
QuickFacts selected in the Active Project drop-down list.

2. Click the Run link next to the Validate compliance with standards task.

Dialogs appear briefly and the .WSI is compiled into a .MSI. The Welcome dialog for
the Package Validation tool appears, listing the predefined validation tests that can
be performed. To see a description of each test, click the test name, and the
description appears at the right of the dialog.

3. Mark Windows Installer SDK Internal Consistency only. If necessary, clear all
other checkboxes.

4. Click Next.

The test runs. This might take a few minutes. When the test finishes, the View /
Correct dialog appears, which lists all the possible problems detected.

Normally, no errors appear for QuickFacts, although for more complex installations,
errors are more likely to appear. If there were errors and if the Correct button
became enabled when the error was selected, you could click Correct to resolve the
problem. Otherwise, you would open the installation in Windows Installer Editor, fix
the error, and recompile. Errors are documented in the Windows Installer SDK Help.
Start with the topic Internal Consistency Evaluators - ICEs.

5. Click Finish on the View / Correct dialog.

You have finished validating the QuickFacts installation package. On the Projects tab, the
checkbox next to the Validate compliance with standards task is marked to indicate that
the task is complete. Next, you will test the package.

e If you have Test Expert, which comes with the Quality Assurance module, you will
use it to test. See Test the Package With Test Expert on page 61.

e Otherwise, see Test the Package Without Test Expert.

Test the Package Without Test Expert

Note

Follow this procedure if you don’t have the Quality Assurance module. If you have the
Quality Assurance module, skip this procedure and follow the steps in Test the Package
With Test Expert on page 61.

In this procedure, you test the QuickFacts package. The Test package task installs the
QuickFacts application on your computer. Then you perform tests to verify that the
application works as expected.

Normally, a package would require more thorough testing. To test in a corporate
environment, you would copy the finished .MSI file to a file server or other media, such
as a CD. Then you would install the application on computers that are representative of
the target computers and test it.

Before you follow this procedure, you must have completed the previous procedure in
this tutorial—Validate the Package on page 59—as well as all preceding procedures.
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To test the package without Test Expert:

1. Use Add/Remove Programs from the Control Panel to uninstall the copy of
QuickFacts that you installed during the first part of this tutorial.

You uninstall because during this procedure, you install and test the repackaged
version of QuickFacts. Removing the original QuickFacts ensures that you test only
the repackaged installation.

2. Make sure you are in Wise Package Studio with the Projects tab selected and
QuickFacts selected in the Active Project drop-down list.

3. Click the Run link next to the Test package task. The repackaged QuickFacts
installation begins.

4. Step through the installation, accepting all the defaults.
5. After the installation finishes, open QuickFacts.
6. To check the QuickFacts installation, verify that its:
m  Shortcuts were created
m  Registry entries were created
m  Files were installed
7. To test the QuickFacts application, use every function.
m  In the Select an item to see facts list, select all 3 items, one at a time.
m  Select Help menu > Help Contents.
m  Select Help menu > QuickFacts Readme.
m  Click About in the lower right of the QuickFacts dialog.

8. Unlike with other tasks, the checkbox next to the Test package task is not marked,
because additional testing might be necessary (example: testing on a clean
machine). In this tutorial, you will not perform additional testing. On the Projects
tab, mark the checkbox next to the Test Package task.

You have finished testing the package installation.

Next, you will distribute the package to the share point directory; see Distribute the
Package on page 64. Skip the next section, which is applicable only if you have the
Quality Assurance module.

Test the Package With Test Expert

> Quality Assurance module only.
If you don’t have the Quality Assurance module, skip this section and follow the steps in
Test the Package Without Test Expert on page 60.

In this procedure, you perform integration and acceptance testing of the QuickFacts
package. The Test package task runs Test Expert, which generates a master test plan
based on the contents of a package and guides you through the execution of various test
cases. This makes the testing process more efficient and focused, eliminating the
random approach often used in an ad hoc testing environment. Test Expert performs
analysis on .MSl-based installations only.
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Before you follow this procedure, you must have completed the previous procedure in
this tutorial—Validate the Package on page 59—as well as all preceding procedures.

Note
Under normal testing conditions, Test Expert requires a clean machine to ensure the
integrity of the repackaged installation.

To test the package with Test Expert:

1.

Use Add/Remove Programs from the Control Panel to uninstall the copy of
QuickFacts that you installed during the first part of this tutorial.

You uninstall because during this procedure, you install and test the repackaged
version of QuickFacts. Removing the original QuickFacts ensures that you test only
the repackaged installation.

Make sure you are in Wise Package Studio with the Projects tab selected and
QuickFacts selected in the Active Project drop-down list.

Close all applications other than Wise Package Studio, including background
applications that might create or change files on the computer.

Click the Run link next to the Test package task.

Dialogs appear briefly and the package is recompiled. The Test Expert window
appears, with QuickFacts.msi opened.

Note
If Test Expert does not open, it means you don’t have the Quality Assurance
module. Follow the steps in Test the Package Without Test Expert on page 60.

When you open a package in Test Expert, the Master Test Plan for that package is
displayed. Each time you open the package, the package is read and test cases are
generated based on the contents of the package. In addition to the Master Test Plan,
you can add user-defined test cases to fully test the package for the requirements of
your organization. In this tutorial, you perform only 2 of the test cases provided in
the Master Test Plan.

In the Installation Tests section in the left pane, select the Verify Installation test
case.

The Verify Installation page appears in the right pane. This test case ensures that
the installation runs without errors by installing the QuickFacts package you created
during SetupCapture.

Click Install on the toolbar at the top of the window. Then, in the Welcome dialog,
click Cancel to skip the Machine Capture.

Machine Capture is necessary only if you plan to perform Uninstall Tests, which are
skipped in this tutorial.

The QuickFacts Setup program opens in front of Test Expert.

In the QuickFacts Setup program, step through the installation, accepting all default
settings. This installs the QuickFacts package.

If the QuickFacts installation ran without errors, from Status of Test Case, select
Passed. A check mark icon appears next to the Verify Installation test case.

In the Application Execution Tests section, select the File Coverage test case.
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A list of all files accessed by the QuickFacts application appears on the All Test Items
tab in the right pane. The File Coverage test case indicates which installed files are
accessed as the application is run.

10. Click Run on the toolbar.
The Run Application Execution Tests dialog appears.

11. In the File to Run list, select QckFacts.exe and click OK.
The QuickFacts application opens and the Application Monitor window appears.
Note
You must leave the Application Monitor window open while you exercise the
functionality of the application because your system is monitored only when it is
open. Move or minimize it if necessary.

12. To test the QuickFacts application, use every function.
m  In the Select an item to see facts list, select all 3 items, one at a time.
m  Select Help menu > Help Contents.
m  Select Help menu > QuickFacts Readme.

m  Click About in the lower right of the QuickFacts dialog.

As files are accessed, the Application Monitor window is updated. When you finish
testing, the File Coverage graph in Application Monitor indicates the percentage of
the files that were accessed.

Note

Some files are not accessed by an application during normal use. Example: In the
QuickFacts application, License.txt is not accessed during normal application
execution.

13. To return to Test Expert, click Exit in the QuickFacts application and close the
QuickFacts ReadMe.
14. Close the Application Monitor window. Monitoring does not stop until it is closed.

On the All Test Items tab, all files except License.txt should display the Passed
status. Because the License.txt file is not accessed during normal application
execution, it has a Pending status. The test items should look like this:
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&l Test ltems | A Pending || o Passed || % Failed

Status | Path | FileM arne | Type

+ Pazzed [ProgramFilesFold...  Birds.bmp BrP File

o Pazzed [ProgramFilesFald...  Birds. qft QeckFacts
« Pazzed [ProgramFilesFold...  Catz.bmp BrP File

« Pazzed [ProgramFilesFold...  Catz.gft HAckFacts ...
« Pazzed [ProgramFilesFold... Dogsz.bmp BrP File

« Pazzed [ProgramFilesFold... Dogs.gft HAckFacts ...
ﬁ_’\ Pending [ProgramFilesFold...  License.tdt Test Docu...
« Pazzed [ProgramFilesFold...  QckFacts exe Application
« Pazzed [SpztermFaolder] QFGUITAR. I Application...
« Pazzed [ProgramFilesFold...  QuickFactz kip Compiled H...
« Pazzed [ProgramFilesFold...  QuickFactz. cnt Compiled H...
+ Pazzed [ProgramFilesFold...  FReadte.txt Text Docu...

15. To set the status of the License.txt file to Passed, double-click the License.txt file
on the All Test Items tab.

The Test Item Details dialog appears.
a. From Status, select Passed.
b. In Test Details, type:
This file is not accessed during normal application execution.
c. Click OK.
16. On the File Coverage page, from Status of Test Case, select Passed.
Note
You might notice that the bold type is removed from all test case names under
Application Execution Tests, which indicates they have been run. This is because all
Application Execution Tests are run simultaneously.
17. Close Test Expert.

For the purposes of this tutorial, you have finished testing the package. Normally, you
would execute all test cases. On the Projects tab, the checkbox next to the Test package
task is marked to indicate that the task is complete. Next, you will distribute the
package to the share point directory.

Distribute the Package

In this procedure, you distribute the QuickFacts package to the share point directory so
that it can be imported into the Software Manager database. The Distribute to share
point directory task runs Package Distribution silently, which places the package into a
queue for later import by Software Manager.

Before you follow this procedure, you must have completed the previous procedure in
this tutorial—Test the Package Without Test Expert on page 60 or Test the Package With
Test Expert on page 61—as well as all preceding procedures.
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To distribute the package:

1. Make sure you are in Wise Package Studio with the Projects tab selected and
QuickFacts selected in the Active Project drop-down list.

2. Click the Run link next to the Distribute to share point directory task.
A dialog appears briefly and the package is copied to the share point directory.

You have finished distributing the package to the share point directory. On the Projects
tab, the checkbox next to the Distribute to share point directory task is marked to
indicate that the task is complete. Next, you will import the package into the Software
Manager database.

Import the Package into Software Manager

In this procedure, you import the QuickFacts package into the Software Manager
database. The Import into Software Manager database task runs Software Manager
silently, which imports the package. Software Manager administers the information
stored in the Software Manager database.

Before you follow this procedure, you must have completed the previous procedure in
this tutorial—Distribute the Package on page 64—as well as all preceding procedures.

To import the Package into Software Manager:

1. Make sure you are in Wise Package Studio with the Projects tab selected and
QuickFacts selected in the Active Project drop-down list.

2. Click the Run link next to the Import into Software Manager database task.

A dialog appears briefly and the package is imported into the Software Manager
database.

You have finished importing the QuickFacts package into the Software Manager
database. On the Projects tab, the checkbox next to the Import into Software Manager
database task is marked to indicate that the task is complete. Next, you will detect and
resolve software conflicts.

Resolve Conflicts with ConflictManager

In this procedure, you compare the QuickFacts package to the Sample Conflict package
you imported earlier. The Resolve conflicts task opens ConflictManager, which detects
and resolves software conflicts before you deploy applications throughout your
organization.

By default, conflict detection is set to run automatically when you import a package into
the Software Manager database. This is controlled by the Detect conflicts during
package import checkbox in Conflict Settings. You can override this setting for specific
packages during package import, by marking or clearing the Detect conflicts during
package import checkbox on the Import Type dialog.

Because conflict detection was run during package import, you do not have to detect
conflicts in this step.

Before you follow this procedure, you must have completed the previous procedure in
this tutorial—Import the Package into Software Manager on page 65—as well as all
preceding procedures.
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To resolve conflicts with ConflictManager:

1. Make sure you are in Wise Package Studio with the Projects tab selected and
QuickFacts selected in the Active Project drop-down list.

2. Click the Run link next to the Resolve conflicts task, which launches ConflictManager.
If the Detect Conflicts dialog appears, click Cancel.

3. Expand the QuickFacts tree in the Applications/Packages pane and select the
QuickFacts version 3.0 package.

In the Conflict List pane, a conflict for QFGUITAM.dIl appears. The red exclamation
point next to it indicates that it is classified as an error. If warnings existed, which
are not as serious as errors, they would appear in this list with yellow question mark
icons.

4. To fix the conflict, select Conflicts menu > Resolve.
The Welcome dialog of the Resolve wizard appears.
5. From Application, select QuickFacts.
QuickFacts version 3.0 appears in the Package field.

6. From Isolation method, select Isolated Components (Windows 98 SE/Me/
2000/XP/2003).

Isolating a conflict means that each application will use its own version of the
conflicting file. The files will be stored in different directories, and will be managed
by Windows Installer.

7. Click Next.

The File Conflicts dialog appears. The upper list box contains the name and
information of the file in your package that has conflicts (QFGUITAM.dII). The lower
list box contains the package and file that QFGUITAM.dII conflicts with.

8. Select QFGUITAM.dII in the upper list box and click Move on the right of the File
Conflicts dialog.

The exclamation point becomes white to indicate that the problem has been fixed.
Because you selected Isolated Components as the Isolation Method, the Move
button isolates the file so that each package that uses QFGUITAM.DLL will use its
own version. This means that a copy of QFGUITAM.DLL will be installed into the
QuickFacts directory, and QuickFacts will reference its own copy of the .DLL file.

9. Click Next on the File Conflicts dialog.
The File Conflicts in Registry dialog appears, which should be empty.
10. Click Finish.

In the Conflict List pane, a yellow question mark icon appears next to QFGUITAM.dII.
The file conflict has been resolved by isolating the file in different directories but is
still listed as a warning. This is because 2 installation packages install a non-16-bit
file with the same file name but different file information (file version number or
date/time) to different directories. Also, the File Conflicts bar graph in the Summary
pane indicates 1 warning.

11. To view only errors (red exclamation points) in ConflictManager, not warnings
(yellow question marks), do the following:

a. Select Conflicts menu > Filter to display the Filters dialog.
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b. In the Conflict Types to Display section, clear Warnings.

c. Click OK.

The conflict filter is globally set to show only errors in the Conflict List pane.
12. Select Packages menu > Export and Recompile.

The Export Changed Packages and Recompile dialog appears, listing the QuickFacts
package.

13. Mark the checkbox for the QuickFacts package. Also, mark Compile the packages
after export and click OK.

Several progress dialogs appear briefly during the export.
14. When progress dialogs stop appearing, close ConflictManager.

The file change is made in the QuickFacts.wsi file with which you’ve been working,
which is in the Projects\QuickFacts subdirectory of the share point directory. It is
also compiled to a file named QuickFacts.msi. The conflict that it had with the
Sample Conflict package is now resolved because each package will use its own
version of the .DLL file instead of one .DLL overwriting the other .DLL.

You have finished resolving conflicts. On the Projects tab, the checkbox next to the
Resolve conflicts task is marked to indicate that the task is complete.

If you don’t have the Quality Assurance module, all the tasks in the Package Testing
phase of the Repackaging for Windows Installer process are complete. If you have the
Quality Assurance module, the Package Testing phase contains 3 additional tasks:
Prepare package for deployment, Deploy instrumented package, and Analyze Results.
This tutorial skips these tasks because they require integration with other computers.

Next, you make the package available for distribution to end users.

Make the Package Available

In this procedure, you update the status of the QuickFacts package to Available, which is
the first step in the Release Management phase. The Make Package Available task runs
Software Manager silently, which updates the status of the package and copies the
package to the Available Packages subdirectory in the share point directory.

The Available Packages directory provides a centralized location for storing all of your
packages that are complete and available for deployment, and keeping them separate
from packages that are still in development.

Before you follow this procedure, you must have completed the previous procedure in
this tutorial—Resolve Conflicts with ConflictManager on page 65—as well as all
preceding procedures.

To make the package available:

1. Make sure you are in Wise Package Studio with the Projects tab selected and
QuickFacts selected in the Active Project drop-down list.

2. Click the Run link next to the Make Package Available task.

A dialog appears briefly. The package status is updated to Available, and the
package is copied to the Available Packages directory in the share point directory
and marked as Read-only.
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You have finished making the package available for distribution to end users. On the
Projects tab, the checkbox next to the Make package available task is marked to indicate
that the task is complete. Next, you will distribute the package to end users.

Distribute the Package

In this procedure, you distribute the QuickFacts package to a location that can be
accessed by end users. Normally, this would be a shared network drive or a distribution
system. In this tutorial, you distribute it to your local drive. The Distribute package task
runs Package Distribution.

After the package is distributed to end users, the Repackage for Windows Installer
process is complete.

Before you follow this procedure, you must have completed the previous procedure in
this tutorial—Make the Package Available on page 67—as well as all preceding
procedures.

To distribute the package:

1. Make sure you are in Wise Package Studio with the Projects tab selected and
QuickFacts selected in the Active Project drop-down list.

2. Click the Run link next to the Distribute Package task. Dialogs appear briefly and the
package is recompiled.

The Distribution Method dialog of the Package Distribution tool appears. Options are
available based on the type of package and the distribution systems available on the
computer.

3. In the Other Distribution Options section, mark the Network and Installation
options and click Next.

The Network Directory dialog appears.

4. In Network Directory, specify a directory in which to save the installation.
Typically, this would be a shared network drive available to users. In this tutorial,
specify a directory on your local drive.

5. To save the installation with a name other than its current name, enter the new
name in Destination File Name.

6. Click Finish.
The package is distributed to the directory you specified.

On the Projects tab, the checkbox next to the Distribute Package task is marked to
indicate that the task is complete.

You have completed the application repackaging process from capturing an application

to distributing a package to end users. By following this process, you have ensured that
your application is ready for deployment, installation, use, and maintenance within the

context of the infrastructure of your organization.

(Optional.) If you are working in your company’s production database, you should
remove the test applications Sample Conflict and QuickFacts from the database. If this is
necessary, follow the steps in Remove Tutorial Packages from Software Manager.
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Remove Tutorial Packages from Software Manager

To ensure that your Software Manager database contains only production packages,
remove the QuickFacts and Sample Conflict packages.

To remove tutorial packages from Software Manager:

1.

6.

In Wise Package Studio, click the Tools tab. At the top of the Tools tab, double-click
Software Manager.

Software Manager opens.

Select Packages menu > Delete.

The Delete Package dialog appears.

Select both the Sample Conflict and QuickFacts packages.

To delete the package’s source files from the share point directory, mark the
checkbox at the bottom of the dialog.

Click OK.
The Sample Conflict and QuickFacts packages are deleted from the database.

Close Software Manager and Wise Package Studio.

You have completed this tutorial.
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